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CHAPTER 1

Introduction

Thank you for purchasing ScanFont 3.2 - a new product from the creators of FontLab. With ScanFont you
can create a professional looking technically correct digital font in minutes.

A perfect add-on to FontLab or TypeTool, ScanFont  allows you to draw font characters on paper with
physical tools or on the computer screen with virtual tools and copy them to the outline font opened in the
font editor. Click the mouse button a few times and you're done!

Do you want to reuse old "bitmap" fonts that you cannot replace with modern "outline" fonts, like Type 1 or
TrueType? ScanFont will do that for you. ScanFont includes a very precise autotracing algorithm that is
designed to work with characters, so everything that you can print on paper or see on the computer screen
you can transform into a high-quality TrueType or PostScript font.

The key features of ScanFont are:

• High-quality fully customizable autotracing algorithm especially designed to handle characters

• Integrated bitmap editor with more than 20 tools

• 100-level undo/redo

• Automatic detection of characters and strings in a source image

• Support of most scanners through TWAIN interface

• Exporting of individual characters in EPS format

• Easy-to-use drag/drop interface

• Popup menus and property panels everywhere
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About this Manual

The following chapters describe all of ScanFont's features in full detail. They are organised to cover all the
functions in their usual sequence: from preparing and scanning a source image to editing individual font
characters.

Preparing Images

This chapter will help you to reduce the time needed to get quality results with ScanFont by showing you
how to properly prepare a source image for scanning. It also describes all the possible methods of importing
an image into ScanFont.

Editing Images

If a source image needs editing (automatic or manual), this chapter will teach you how.

Splitting an Image

After your image is imported and edited, it is then time to divide it into individual characters. Usually
ScanFont does this automatically, but if manual editing is needed this chapter will help you.

Creating Characters

This chapter explains how to create characters from the prepared and separated image. Autotracing, locating
characters in the font, editing font headers, importing and exporting fonts - are all described here.

System Requirements

ScanFont requires one of following hardware and software configurations:

1. PowerPC-based Macintosh computer running Mac OS 7.6.1 or later.

2. FontLab 3.1 for Macintosh, TypeTool 1.3 for Macintosh or any other FontLab server application installed.

2. At least 16 Mb RAM (more RAM may be necessary to run FontLab 3.1)
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CHAPTER 2

Preparing Images

ScanFont may be used in various ways, but its main function is to convert
images into outline fonts. In this chapter, we will discuss the preparation of
source images. Later, we will talk about editing images, locating characters
in an image and converting the characters' images into outline characters.
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In ScanFont you can use the following sources of images:

• An image of a font or of individual characters printed or written on paper and placed in a scanner

• An image file in TIFF or PICT format

• The Macintosh Clipboard

• The ScanFont bitmap editor window - where you will draw something directly in ScanFont

The easiest way to get an image in ScanFont is to have a scanner connected to your computer; place the
paper with the image into it and scan it using ScanFont. ScanFont supports the TWAIN interface, so it can
work with almost all scanners. (Refer to your scanner's documentation to see whether it will work with the
TWAIN interface.) If your scanner cannot work through TWAIN, you can use the program that comes with
your scanner to scan the image and save it into one of the formats that ScanFont can read.

If you do not have a scanner or it is not connected directly to your computer, you can scan your image, save
it in an image file and import this file into ScanFont.

If you can place the image onto the Clipboard (using the Copy command in any image-editing application),
you can get it from there and paste it in ScanFont as a new image.

If you do not have a prepared font image, but are ready to create it using the mouse or a digitizing tablet, you
can start from a clear image and draw it using ScanFont's image-editing tools.

Scanning an Image

There are several steps that you must perform to prepare and scan your image. The scanning stage is very
critical for the quality of the resulting characters in the font, so please read this section carefully and take the
time to experiment with your scanner and adjust the scanning sequence for the best results.
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Preparation of the Source Image

To get best results we recommend that you prepare a source image (on paper) with the following
characteristics in mind:

• The paper must be white and smooth.

• The ink must be black. You can use blue ink, but it must have high contrast.

• The images of characters or symbols that you want to place into a font must be large. The
real size of the symbols that you want to scan depends on the optical resolution of your scanner. We
recommend that the size of the symbols be at least ½ inch/1.25 cm in height. If you want to get a very
precise result, you can prepare bigger characters, even one huge character on a page. ScanFont can process
such a character, but our experiments have shown that characters bigger than mentioned above do not
really improve the quality of the resulting outlines.

• If you want to scan your signature, write it as usual. The more natural it is, the better the result.

• If you are preparing a font of your handwriting, do not choose a thin pen. A standard 0.7mm pen is
best.

• Never use a pencil! The image will look contrasted on paper, but not when scanned. As a result you will
get noise in the black areas of the image and holes in the characters' strokes.

• If you are creating a handwriting font, try to align the characters on a baseline. You can use a light-
yellow pen to draw lines before you write characters. Low contrast yellow lines will not show up in a
scanned image, but they will help you to align characters properly.

• The distance between each string is not important, but it must be large enough so the characters don't
overlap:

Wrong Right

• If you are not sure what shape of character is better, write several versions, and then choose. Later,
in ScanFont, you can select the best version. It is much better to have several versions of a symbol on one
paper than to make an additional scan, because even if the scanner settings are the same, the position of
the paper in the scanner will differ, so the result will be different.

• Do not overlap characters. ScanFont includes advanced algorithms that can separate characters of any
form, but not when characters "touch" each other. In ScanFont, overlapping or touching characters are
treated as just one character in a strange format. Manual separation of overlapping characters is possible,
but is very time-consuming.

Here is what we mean by "touching" and "overlapping" characters:

 Wrong   Right
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Placing Paper with an Image into the Scanner

If you have a flatbed scanner, place the paper with the image into the scanner. If you have a hand-held
scanner, prepare it for scanning. We do not recommend that you use hand-held scanners to prepare
typographical fonts for ScanFont, because this type of scanner is not precise enough. But, if you are just
adding your signature to an existing font or creating a handwritten or pictorial font, a hand-held scanner is
adequate.

It is very important to put the paper straight on the scanner. The rotation of paper placed into a
scanner, (even if only few degrees) dramatically decreases the quality of the results you will get in ScanFont.
Try several times to make sure that the paper is aligned straight in the scanner.

Selecting the Scanner in ScanFont

According to the TWAIN interface standard, many scanners may be connected to one computer. So, to start
scanning you must select the right scanner.

To select the scanning device in ScanFont

1. Select the Select Source command in the File menu.

2. Select the scanner in the dialog box that appears.

Scanning an Image

To scan a paper-based image in ScanFont

1. Prepare the image according to the recommendations in "Preparation of the Source Image" paragraph.

2. Switch the scanner on.

3. Select the Acquire command in the File menu.

4. Follow the scanner-dependent scanning dialog to scan the image. (Note that scanning modes are limited
to black-and-white (line-art) mode only.)

We recommend that you select 600 DPI as the default scanning resolution. If you scan a small
picture, increase the scanning resolution, if the source picture is big (more than 1 inch in height), 300-400
DPI will be enough.

Do not choose a resolution that is higher than the optical resolution of your scanner. Some
scanners' software let you choose a resolution that is several times higher than the real optical scanning
resolution of your scanner. Additional information necessary to "fill" the increased resolution is generated
automatically by the scanning software. For ScanFont's purposes, this is not necessary and can significantly
decrease the quality of the resulting outlines.



Preparing Images

13

Importing an Image

If you have scanned your image and saved it as an image file, you can import this file into ScanFont.

ScanFont can import images in TIFF or PICT formats. Most of the scanning programs can save images in
these formats.

ScanFont works only with black-and-white images. Black-and-white images include only two colors
- black and white. ScanFont cannot import other types of images, like grayscale (many levels of gray) or
color.

To open an image in ScanFont

1. Select the Open command in the File menu.

2. In the Open File dialog box that appears, select the folder and file that you want to open. You can select
multiple files using the COMMAND and SHIFT key in combination with the mouse or arrow keys.

3. Press Open to open files. If ScanFont cannot open (with a read error, file is of wrong type or image is not
black-and-white) the file, it will open the message box and describe the problem.

You can also open one or more images by selecting the images in Finder and drag-dropping them into
ScanFont.

! Tip: When you open an image file the name will appear on the bottom part of the File Menu. Later, you
can easily open this image again by simply selecting this file name in the menu.
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Importing an Image from the Clipboard

Various Macintosh programs can exchange information by using the clipboard. They use standard formats that all
programs can understand. Bitmap data is presented in one of these formats. If you select and copy an image from
a program, it can be imported into ScanFont. As with image files, ScanFont can import only black-and-white
images. Neither grayscale nor color images can be imported into ScanFont through the clipboard.

Importing The clipboard's contents into ScanFont:

1. Run your Image-Editing program; select the image that you want to import into ScanFont; and Copy it onto
the Clipboard. The Copy command is usually located in the Edit menu. Refer to the documentation or on-line
help of that application for instructions on how to do this.

2. Switch to ScanFont using the  Application Menu or COMMAND-TAB combination of keys to switch between
programs.

3. Select the New Image command from the File menu. You will see the following dialog box:

4. Check that the Create New Image Using Clipboard Contents check box is switched on. If this check box is
not enabled, it means that you do not have the proper image in the clipboard.

In the Dimensions of New Image controls, you will see the size of the image that ScanFont reads from the
clipboard. If you want, you can change the image dimensions to leave, for example, more white space around
an imported image.

5. Press OK. You will see the new image with the Clipboard contents.
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Creating an Empty Image

Sometimes you may not have an image ready, only an idea. You can create an image right in ScanFont, using
the bitmap-editing tools that are of the same quality as in the most well known image-editing programs. But
first you have to create an empty image.

To create an empty image:

1. Select the New  command from the File menu.

2. In the dialog box that appears switch off the Create new image using Clipboard contents check box if it
is enabled.

3. Enter the dimensions of the new image in the edit boxes in the Dimensions of new image area. Be sure
to create the image big enough to include all the characters. If you create the image too small, and later
during editing you find that you have no place to include all of the image, it will not be a problem. You can
always create a new, bigger image and copy the contents of the smaller image into it with an easy drag-
drop operation.
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Viewing an Image

Often the size of the image that you are editing is larger than the size of the window where it appears. You
must have a method to view all of the image. You also may need to see the details of an image in a magnified
mode. Do this using the zoom mode and scrolling.

Selecting Zoom Mode

By default, all images you open appear "fitted" to the Image Window. So, if the size of the image (measured
in pixels) is more than the size of the Image Window, the image will be scaled down to fit into the window.
Some details may be hidden.

To change the zoom mode of an image you must use the buttons and controls on the View toolbar:

There are: Zoom Selection combo box, Zoom In, Zoom Out and mode selection buttons that will be
described later.

In the Zoom Selection combo box , you can select a zoom factor that will be applied to the current
image.

Zoom mode declares a scaling factor that is applied to the image while previewing it on screen. So, if this
scaling factor is more than 1, like 2:1 or 4:1, the image will be enlarged. If the scaling factor is less than 1,
like 1:2 or 1:8, the image will be condensed and will take less screen space. To view more of the image all at
once, in the Image Window you must select a zoom mode where the second number is more than one, and to
see the details of a part of an image, you must choose a zoom factor where the first number is more than 1.
The Zoom factor called Fit will automatically select the actual scale factor to fit the image in the window. A
zoom factor of 1:1 means that one image pixel is represented by one screen pixel.

Zoom mode 1:1 Zoom In mode

There are permanent and temporary zoom modes. In the Zoom selection combo box you are selecting, a

permanent zoom mode will be marked with an '*'. With the Zoom In  button you can select a temporary
zoom mode.
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To select a temporary zoom mode:

1. Click on the Zoom In button  of the View toolbar.

2. Position the mouse cursor  on one of the corners of the image region that you want to zoom in.

3. Press the mouse button and move the mouse to select the region.

4. Release the mouse button. The selected region will be zoomed in and will take up all the possible space in
the Image Window. The new zoom factor will be selected in the Zoom selection combo box.

To return to a permanent zoom mode click on the Zoom Out button  of the View toolbar.

Additional zoom selection operations:

To increase the zoom factor by one level (for example, from 3:1 to 4:1) or by 2 levels (from 3:1 to 5:1)

1. Click on the Zoom In button  of the View toolbar

2. Position the mouse cursor on the part of the image that you want to zoom on. Hold the COMMAND key
down to zoom 2 levels.

3. Click on the mouse button.

To decrease the zoom factor by one or two levels, do the same as you did for increasing the zoom factor, but

hold down the SHIFT key also. When you press the SHIFT key the cursor will change to .

Quick Change Zoom Mode

You may use three small buttons at the bottom left edge of the Image Window for change zoom mode
quickly:

To increase the zoom factor by one level (for example, from 3:1 to 4:1) click in the button .

To decrease the zoom factor by one level, click in the button .

To choose the zoom factor directly, click in the popup-button  and select the zoom factor from the
popup menu.

To set the zoom factor to fit  the desired rectangular area in the whole window

1. Hold down the Cmd and Space keys on the keyboard. The cursor will look like this: .

2. Press the mouse button.

3. Select the desired rectangular area.

4. Release the mouse button.
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Scrolling an Image

When part of an image appears in the Image Window and you want to see other parts of the image you may
use the scroll bars in the right and bottom part of the Image Window to scroll an image.

All image editing tools will autoscroll the image when you move them outside the Image Window. This
feature is very useful, so usually you will not need to use the scroll bars to scroll an image.

To scroll the image quickly:

1. Hold down the SPACE key on the keyboard. The cursor looks like this: .

2. Position the mouse cursor  anywhere in the image.

3. Press the mouse button.

4. Move the mouse in any direction. The image will be moved accordingly.

5. Release the mouse button.

Inverting an Image
Sometimes after scanning or importing an image file you might see that the image is inverted: and the areas
that should be black look white and vice versa. If you want to invert the image, select the Invert command
from the Operations menu.

Original image Inverted image

This command may be applied to the selected areas of an image (we will discuss the selection of the image
areas in the next chapter), but when there is no selection, it will apply to the entire image.
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Rotating an Image

When you are scanning an image sometimes it is easier to rotate it 90 degrees or 270 degrees. If you think
that when scanning you will have fewer errors if the paper with the image is rotated, use this tool. In
ScanFont you can always rotate the image in 90 degree increments.

To rotate an image select the Rotate command in the Operations menu. When you select the command a
popup menu appears with a list of possible rotations: 90, 180 and 270 degrees. You must select one of them
and the image will be rotated. The proportions of the image will be adjusted accordingly.

Original image Image rotated 90 degrees

This command may be applied to selected areas of an image (we will discuss the selection of image areas in
the next chapter), but when there is no selection, it will apply to the entire image.

Undoing and Redoing

Now you know a few of the operations that will affect the entire image. The Invert and Rotate operations are
completely reversible, so you can always return to the initial state of the image, but before you start to learn
about operations that can destroy your image (along with all your work), we want to tell you about one of the
most important features of ScanFont.

All image operations in ScanFont are undoable. So, you can do 100 operations and still return to the original
state of the image. You are free to experiment with an image, because you can always roll back.

To undo the last action, select the Undo command from the Edit menu. Or press COMMAND+Z. Or, click on

the Undo button  in the Standard toolbar.

If you repeat the Undo command you will undo the previous action and so on.

To redo the previously undone action, select Redo from the Edit menu. Or, press COMMAND+SHIFT+Z.

Or, click on the Redo button  on the Standard toolbar.

If you do something with your image, then select Undo several times to return to the source state, you can
select Redo to return your work to the image.
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Flipping an Image

When you want to flip an image in a vertical or horizontal direction, you should use the Flip Horizontal or
Flip Vertical commands from the Operations menu. This operation may be necessary when you scan the
negative of an image.

Original image Horizontally flipped image

As with other commands from the Operations menu this command may be applied to selected areas of an
image (we will discuss the selection of image areas in the next chapter), but when there is no selection, it will
apply to the entire image.

Enhancing an Image

If the source image has some black or white noise, you may use the Enhance Image command from the
Operations menu to eliminate it.

Black noise is small (1-5 pixel size) spots on the white areas of the image. You should expect some black
noise if you scanned old or not-so-white paper. During enhancing, ScanFont detects such spots and tries to
remove them.

White noise is small white spots on the bodies of the characters. It appears when you use a low-contrast pen
or the scanning options are not optimal.

Before enhancing After enhancing

You may use the Enhance operation several times, because it is possible that each use will improve the
quality of the image. You can choose the best result by using the undo and redo commands
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Saving and Exporting an Image

When you modify and enhance a source image it is a good idea to save the changes that you have made. You
can save an image in ScanFont's own format or in one of the standard image file formats.

ScanFont's own image format (SFI - ScanFont Image) can store much additional data, like information
about the characters that appear after splitting an image (this will be discussed later in the chapter "Splitting
an Image"). So, we highly recommended that you save the images in ScanFont's format.

When you need to use or edit an image in other than a ScanFont application, you may save the image in
TIFF or PICT format.

To save an image:

1. Select the Save As command in the File menu.

2. In the standard File Save dialog box that appears, select the folder where you want to save the image and
enter its name.

3. Press Save to save the image.

When you open an existing image or have already saved one by using the Save As command, you can use the
Save command from the File menu to save it into an existing file.
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CHAPTER 3

Editing an Image

If you want to modify a scanned or imported image, or if you created an
empty image and want to draw something, you can use ScanFont's image
editing tools and operations. There are two groups of image-editing tools:
selection tools and drawing tools.

With selection tools you can select part of an image and apply some kind of
transformation to it. Or, you can just copy it onto the Clipboard, or into
another image opened in ScanFont, or as a character into a font.

With drawing tools you can modify an existing (scanned or imported image)
or draw a new picture on the image. Using the drawing tools, you can create
exciting effects with existing fonts that you cannot do using other methods.

You can always look at the status bar line in the bottom part of the
ScanFont main window. It contains "live" recommendations for usage of all
image editing tools.
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Overview of Toolbox

There are two toolboxes relating to image editing. The Tools toolbox and the Brushes toolbox. The Tools
toolbox includes all the editing tools and the Brushes toolbox includes the additional options buttons. For
example, the selection of color, the shape and width of brush strokes and transparent or opaque drawing
modes:

   

Selecting

Using selection you can choose part of the image that you want to move, copy, autotrace or otherwise
modify. The selection areas may be of a simple rectangular form or of any form that you can draw.

There are 3 tools that can make selections:

Select Selects a rectangular area

Select Region Selects areas of arbitrary form

Magic wand Automatically determines the selection area

Selection areas may be combined. Holding down the SHIFT key while performing the selection adds the new
selection to the existing selection.
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Marquee Selection

Marquee selection is the simplest selection method. It allows you to select a rectangular area of an image.
However, when using the Add selection function you can select more complex areas.

To select a rectangular part of an image

1. Choose the Select  tool from the Tools toolbox.

2. Put the mouse cursor on one of the corners of the rectangle that you want to select.

3. Press the mouse button and move the mouse to the marquee selection area with the rectangle that
appears. If you move the mouse cursor outside of the Image Window, you will see that the image
automatically scrolls, allowing you to select a larger rectangle.

4. Release the mouse button.

Press the ESC key while making a selection to abort the selection procedure.

To add a new rectangular selection to the existing selection, hold the SHIFT key on the keyboard while

selecting. The cursor will change to .

To remove the selection area, click the mouse button in any non-selected part of the image.
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Freehand Selection

With the Select Region tool, you can select areas of any form. The area may be selected on a point-by-point
basis or by drawing a freehand line.

To select a free-form area with the Select Region tool:

1. Choose the Select Region tool  in the Tools toolbox.

2. Position the mouse cursor on one of the points of the selection area edge.

3. Press or click the mouse button. If you click the mouse button, you will add a new straight line to the
selection polygon. If you press the mouse button and drag the mouse, you will draw a freehand line that
will be added to the selection.

4. Double-click the mouse button to finish the selection or click the mouse button with CTRL key pressed to
abort.

Hold down the SHIFT key on the keyboard to add a new selection to the existing one, or hold down the CMD

key and click on one of the existing selection areas to deselect them.

Magic Wand Selection

The easiest selection tool is the Magic Wand. It automatically detects areas to select and creates freehand
selections. It is very useful in selecting a single character to be placed into a font. In the Add mode, this tool
may be used to select more than one character.

To select a black area with the Magic Wand selection tool:

1. Select the Magic Wand tool  in the Tools toolbox.

2. Move the mouse cursor  near the black picture that you want to select. The best way is to move the

cursor onto this picture.

3. Click the mouse button to select the picture.

Hold down the SHIFT key to add a new selection to the existing ones or hold down the CMD key and click on
the selected area to remove existing selections.
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Other selection commands

To select a whole image, select the Select All command from the Edit menu.

To void selection, select the Deselect command from the same menu.

Both commands are available in the Image Window popup menu that appears if you press the mouse
button with CTRL key pressed.

Operations on a Selection

Selection itself is not a very useful operation. It is used just to choose part (more or less complex) of the
image to apply transformations to. In this section we will discuss methods of transforming selected areas.

Moving a Selection

There are two main operations on selected areas: moving within the Image Window and drag-dropping into
other image windows.

The type of moving operation is automatically detected by ScanFont and depends on how close to the edge of
the selection area you press the mouse button:

Move selection Drag-drop selection

Several operations depend on how you start the particular operation. For example, to deselect the selection
area, click on this area while holding down the CMD key. On the other hand, if you hold down the CMD key
and drag the selection area that will copy the selection.

To move a selected area

1. Choose a selection tool (Select, Select Region or Magic Wand).

2. Move the mouse cursor inside the selection area. If you move the cursor close to the edge of the selection,
you will see that the cursor changes to the drag-drop cursor . This means that you are not moving, but

dragging. Move the cursor closer to the center of the selection. The cursor looks like this: . If it

doesn't, change the zoom mode to increase the visible size of the selection.

3. Press the mouse button and drag the selection to the new place.

4. Release the mouse button to finish moving or press the ESC key on the keyboard to abort the operation.

To constrain movement to the horizontal or vertical direction, hold down the SHIFT key while pressing the

mouse button (the cursor will change to ) and drag the mouse.

To instantly copy a selection, hold down the CMD key (the cursor will change to ) while pressing the

mouse button to start moving.
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Transparent and Opaque Modes

There are two drawing modes you can use when you moving selections:

Opaque mode: you can move the entire selection, including black and white areas that work together as an
object. In this case the white areas in the selection overlap the black areas on the underlying image.

Transparent mode: this only works on the black parts of the selection. Only the black areas in the selection
will overlap the underlying image and the white areas will be completely transparent.

 

Opaque mode Transparent mode

To select the Transparent or Opaque mode you must use the mode selection buttons in the Brushes toolbox:

To choose Transparent mode

 To choose Opaque mode

Deleting a Selection

To remove a selection from the image, select the Delete command in the Edit menu or press the DEL key on
the keyboard. The selection will be removed and filled with white color.

Don't forget you can use the Undo command if you want to undo the deletion.

Copying and Pasting a Selection

To copy a selection into another Macintosh program or into another image in ScanFont, use the Copy and
Paste commands from the Edit menu.

With the Copy command you can place a copy of the selection area into the Macintosh Clipboard, making it
available to any application that can read bitmap images.

The Paste command reads black-and-white bitmap images from the clipboard and places them into the
current image.

The Cut command combines Copy and Delete operations, so a copy of the image is placed on the clipboard,
but the selection is deleted.
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Drag7Drop Copying

To copy a selection from one image to another image simultaneously opened in ScanFont, it is not necessary
to use the Clipboard-related Copy (Cut) or Paste commands. You can use the drag-drop copying method.

To copy a selection into another image

1. Make the selection using any of the selection tools.

2. Move the mouse cursor near to the edge of the selection area. The cursor shape will change to: 

3. Press the mouse button and drag the mouse cursor to the Image Window where you want to copy the
selection.

4. Release the mouse button to finish the drag-drop copying .

Transforming a Selection

You can use the commands from the Operations menu to transform a selection area of an image. These are
the same commands that you can use on the entire image as discussed in the previous chapter. If you have a
selection within the image, transformation commands are applied to the selection, if there is no selection the
commands are applied to the entire image.

Here is list of commands that you can use to transform a selection:

Enhance Image Minimizes black and white noise on the
selection area

page 20

Invert Inverts the image colors page 13

Flip Horizontal
Flip Vertical

Flips the image page 20

Rotate Rotates the image by 90, 180 or 270 degrees page 19
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Popup Menu

In ScanFont you can press the mouse button with CTRL key pressed in several places to get a popup menu
that contains useful commands.

In the Image Window, the popup menu can be accessed only if you select the tools that do not require you to
use the mouse button with CTRL key pressed. Because none of the selection tools use it, you can open the
popup menu easily.

In the Image Window, the editing mode popup menu contains the following commands:

Cut
Copy
Paste
Delete
Select All
Deselect

These are the complete equivalents of the commands in the Edit menu.

Place into
Font

Places a selection into a font as an outline character as will be described later.

Show Split Changes the modes of the Image Window. This will be described in detail later

Drawing Tools

You can draw a new picture or modify an existing image using drawing tools. ScanFont's image editor
includes the following drawing tools:

Pencil Draws thin 1-pixel lines or sets or clears individual pixels. Very useful in the Zoom-In
mode.

Brush Main drawing and painting tool. Draws strokes of selected width and shape.

Eraser Clears areas of a picture.

Fill Fills closed areas of white or black color.

Line Draws straight lines.

Polygon Draws filled polygons.

Rectangle Draws rectangles or squares.

Ellipse Draws circles and ellipses

Text Enters text

All the tools except the Text tool, may draw with either color. The default color works when you use the
mouse button to draw, and an alternate color works when you draw with the mouse button with CTRL key
pressed.

Usually the default color is black and the alternate color is white. You can change the default and alternate
colors using the color selection buttons on the Brushes toolbar: 
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 Pencil

Pencil is the simplest tool in ScanFont. It draws a one-pixel-wide line or can be used to set or clear
individual pixels. The best result that you can get in zoom mode is 1:1 or greater.

To set or clear individual pixels on an image, move the mouse cursor  onto the pixel you want to
edit and click the mouse button. This sets a pixel to the default color. Use the mouse button with CTRL key
pressed to set it to the alternative color.

To draw a thin line, press the mouse button and drag the mouse to draw a line with the default color.
Holding down the CTRL key to draw a line of the alternative color.

Press the ESC key on the keyboard while drawing to abort drawing a line.

 Brush

Brush is a wide version of pencil. You select the brush shape and width in the Brushes toolbox, choose the
default or alternative colors and draw lines with the brush tool.

To use the brush tool:

1. Select the brush size and shape in the Brushes toolbox. Brush widths (in pixels) are

1 3 7 11 15

2. Select the Brush tool  in the Tools toolbox

3. Draw brush strokes with the mouse button for the default color and mouse button with CTRL key pressed
for the alternative color.

4. If you want to cancel drawing, press the ESC key on the keyboard.

 Eraser

The Eraser tool may be used to clear portions of the image. Of course, the brush tool with an alternative
color may be used also, but the Eraser tool is usually larger and faster.

The size of the eraser depends on the current brush size that you can select in the Brushes toolbox. The
eraser size is not measured in image pixels. Its size is measured in screen pixels. In any zoom mode the
visual size of the eraser rectangle will be the same.

As with other tools you can use the CTRL key to choose the default or alternate color. But in the Eraser tool,
these colors are switched. The default color for any other tool is the alternative color for Eraser. For
example, if you choose the black color for default drawing with all tools, Eraser will use the white color as
the default.

Of course, you can press the Esc key to abort.
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 Fill

The Fill tool is used to fill areas surrounded by one color.

To fill a closed area using the Fill tool

1. Select the Fill tool  in the toolbox.

2. Move the mouse cursor  to the area you wish to fill.

3. Click the mouse button to fill this area with the default color. Holding down the CTRL key to fill with the
alternative color.

Black fill White fill

 Line

This tool draws straight lines with the brush that you select (shape and width).

To draw a straight line

1. Select the Line tool  in the toolbox.

2. Position the mouse cursor  at the beginning of the line.

3. Press the mouse button to draw the line with the default color and holding down the CTRL key to draw
with the alternative color. Drag the mouse to define a line.

4. Hold down the SHIFT key on the keyboard to constrain the line direction to 45 degree increments.

5. Release the mouse button to finish drawing the line or press the ESC key on the keyboard to abort.
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 Polygon

This tool may be used to draw closed polygons with the interior filled using default or alternate colors.

As with all other tools you can switch between default and alternate colors, holding down the CTRL key.

To draw a polygon:

1. Select the Polygon tool  in the Tools toolbox.

2. Position the mouse cursor  on the first point of the polygon.

3. To add a straight line segment to a polygon, click the mouse button Then move the mouse to define the
line segment and click the button again. Hold down the SHIFT key on the keyboard while drawing the line
segment to constrain its direction to 45 degree increments. Hold down the CTRL key to choose the
alternate color.

4. To add a freehand segment to a polygon, press down the mouse button (but do not release it) and drag
the mouse drawing the freehand segment. Release the button to accept it.

5. To finish drawing a polygon, double-click the mouse button that you used to draw the polygon.

6. To abort drawing, press the ESC key on the keyboard.
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 Rectangle and  Ellipse

These two tools are very similar in usage, but differ in result. The Rectangle tool is used to draw rectangles
and squares, and the Ellipse tool draws ellipses and circles.

To draw a rectangle or an ellipse

1. Select the appropriate tool,  or  , in the Tools toolbox.

2. Position the mouse cursor  or  on one of the rectangle's corners. If you are drawing an ellipse,

position the cursor on one of the corners of the rectangle that surrounds the ellipse.

3. Press down the mouse button and drag the mouse to draw a rectangle or an ellipse. Hold down the CTRL

key to choose the alternate color.

4. Hold down the SHIFT key on the keyboard while drawing to draw a square instead of rectangle, or circle
instead of an ellipse.

5. Hold down the CMD key to place the center of the ellipse or rectangle at the same place where you
pressed the mouse button the first time.

6. Release the mouse button to finish drawing or press the ESC key to abort.
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 Entering Text

With this tool (which is a little more complex than the other drawing tools) you can draw letters, words or
paragraphs of text using any font installed in your system. This feature is very important, because it allows
you to use any font (not only TrueType or Type 1) as an original for further modifications and tracing. Using
this tool you can convert any font on your screen into a high-quality TrueType or Type 1 outline font.

The Text tool always works in the default color, so if you want to change the current default color, use the
color selection buttons in the Brushes toolbox.

To draw a string of text:

1. Select the Text tool  in the Tools toolbox.

2. You will see a text entering panel:

In this panel you can enter a line of text and choose the font that will be used to draw the text.

3. Press the Change font button to select the font. You will see the font-selection dialog box where you can select
the typeface, style and point size of the text that you are drawing. If you want to enter comment strings on your
image, use fonts with a point size of 8 points or less. If you want to trace this text it's best to use at least 72
point size.

4. Type the text that you want to draw on the image (or press the Put All ASCII Symbols button to insert all
characters from the ASCII characters set). You will see the text objects containing the entered text
immediately appear on the image while you are entering:

5. You can work with the text object as with any selection. Use the Text tool just like any other selection tool
to move or copy a text object. Refer to page 24 for information about selection tools.

6. Choose a transparent or opaque mode for the text object.

7. Double click the mouse button anywhere in the Image Window to accept the position of the text object
and begin entering a new one.
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4

CHAPTER 4

Splitting an Image

The main purpose of ScanFont is to transform images of characters into an
outline font. ScanFont restores information that is lost during printing or
writing a character's shapes. When characters appear on paper (or on the
computer-stored image) they are not characters anymore. They are nothing
more than a collection of black spots of various shapes.
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When we read an image of text, we:

1. Separate each character from the other characters.

2. Analyze the characters' shapes and recognize their meaning.

To restore fonts from the image, ScanFont performs exactly the same two steps. It has to separate the image
of each character from the images of other characters and put this character in the proper position in the
collection of characters that is called a font.

Because there are differences between the shapes of the same character in different fonts, ScanFont cannot
automatically recognize characters, like Optical Character Recognition (OCR) programs do. OCR programs
are oriented to recognize a limited number of fonts and include an advanced lexical-based-processor that
minimizes recognition errors by trying to understand words, not just separate characters. In ScanFont we
usually do not have words, just a collection of characters in the same order. It is virtually impossible for us to
create a recognition algorithm that will understand characters in ScanFont. But, we have created tools that
simplify manual character recognition and have included a special feature that can automatically recognize
characters if they are printed in a known sequence.

ScanFont can automatically separate characters, but you of course, can manually separate characters using
one of the selection tools described in the previous chapter. Our automatic separation feature, called
autosplit, usually produces very good results requiring few or no manual corrections.

The sequence of converting an image to a font is:

1. Prepare the source image.

2. Import the image into ScanFont (by scanning or importing).

3. Correct the image in ScanFont using image-editing tools and operations.

4. Autosplit the image.

5. Manually correct the autosplit results.

6. Place the character into a font.

In this chapter we will discuss autosplitting and manual split editing functions of ScanFont.
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What is Splitting?

To let you better understand how ScanFont autosplits an image, we will explain the steps here.

First, ScanFont traces the shapes that it finds in an image. Some characters include two or more shapes, like
the character 'i'. These shapes must be combined to minimize further manual adjusting of autosplitting.

ScanFont needs to perform an additional analysis of shapes to find candidates that must be merged. To
perform this analysis ScanFont builds split cells - bounding rectangles of each shape. Then ScanFont tries to
get additional information from the text that is usually aligned to strings. It analyzes split cells and divides
the complete collection of cells into a number of strings. This string determination is preliminary and will be
adjusted when the final analysis is done.

When ScanFont determines what the strings are, it is then time to try to merge the cells. There are two types
of cells to be merged:

1. Cells that seriously overlap

2. Cells that stay on top of other cells in the same string

Both tests are performed, and the final collection of cells is generated. The advanced string location
algorithm produces a final set of strings. Strings are necessary to understand the actual size of a characters'
shapes and to automatically determine the position of the characters' baselines.
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Here are definitions of commonly used words:

Strings of text:

Font height

Characters height

As you can see, there is a baseline on which all characters are aligned. There is also a height value that
determines the normal distance between strings. This height value is equal to the distance between the
baselines of two strings in the text. We will call this value the font height. As you can see, the real height of
the uppercase letters is less than the font height. In most fonts the ratio between the height of the uppercase
letters and the font height is about 7:10.

The font height is used when a scaleable outline font must be scaled to fit in a particular point size on a
device with a given resolution. ScanFont reverses the printing process and determines the font height from
the font. When the autosplit operation locates all the strings and determines the baseline's position it can
measure the distance between two baselines and has the font height measured in image pixels. This
information is enough to compute a scale factor that will be used to produce outline characters of the proper
size.
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Splitting an Image

To automatically split an image select the Separate Shapes command from the Operations menu.

After processing you will see that the view of the Image Window has changed. This means that splitting has
successfully been completed and you are now in the Split mode of the Image Window.

View Modes of the Image Window

There are two view modes of the Image Window: Image and Split. The Image mode is used when you
want to edit an image. The Split mode works with splitting information.

To change between modes of the Image Window, use the mode selection buttons of the Standard
toolbar:

To switch to Image mode (default when you open or create an image)

To switch to Split mode

When you open an image and switch to Split mode for the first time and there is no splitting, the Separate
Shapes operation performs automatically.

After splitting, you can switch to the Image mode by selecting one of the image editing tools, and the mode
will change automatically.

If you are in Image mode and the splitting information for an image is present you can switch to Split
mode by selecting one of the Split-editing tools.

Editing Splitting Data

There are no perfect automatic algorithms. Possible errors of the autosplit algorithm are:

1. If two characters touch or overlap each other too much they will be interpreted as a single character. The
split cells must be separated manually:

2. Some multi-part characters will be interpreted as being separate characters. The split cells must be
merged.

3. The positions of some of the baselines may be inaccurate. New baselines must be added or unnecessary
baselines removed.

There are two split-editing tools that are used to fix these errors: the Symbol tool and the Knife tool.

The Symbol tool is used to select split cells, move, add or remove baselines, and drag-drop cells to a font.
This is the main tool of the Split mode.

The Knife tool is used to divide cells formed by touching characters.
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Selecting Cells

To select a split cell:

1. Select the Symbol tool  from the Tools toolbox.

2. Position the mouse cursor on the cell that you want to select.

3. Click the mouse button to select this cell. Hold down the SHIFT key to add this cell to the number of
previously selected cells.

To deselect a cell with the Symbol tool click on the selected cell while holding down the SHIFT key on the
keyboard.

To deselect all selected cells, click outside any cell or choose the Deselect command from the Edit menu.

To select many cells at once:

1. Select the Symbol tool.

2. Position the mouse cursor somewhere near the cells that you want to select.

3. Press down the mouse button and drag the mouse to touch the cells that you want to select by using the
rectangle that appears. Hold down the SHIFT key to add newly selected cells to the number of previously
selected cells.

4. Release the mouse button to finish your selection.
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Merging Characters

You can merge as many cells as you want. This may be necessary if some characters are not properly
separated. Usually this happens if the symbol's images consist of several parts:

To merge the characters' cells:

1. Select the cells that you want to merge using the Symbol tool.

2. Select the Merge command in the Operation menu. Or, press the mouse button with CTRL key pressed
and select the same command in the popup menu. Or, press the CMD and the gray Plus key on the
keyboard.

The selected cells will be combined into one cell.

Manual Splitting

Sometimes when ScanFont tries to automatically merge cells that belong to one character it merges cells that
should not be merged. In this case you must separate these cells manually.

! Tip: If too many cells are merged, you may have to switch off the Smart Split options that are used to
automatically merge the cells. Refer to page 52 for instructions on how to change the autosplit options.

To manually split cells:

1. Select the cells that you want to split using the Symbol tool.

2. Select the Split command in the Operation menu. Or, press the mouse button with CTRL key pressed
and select the same command in the popup menu. Or press the CMD and gray Minus key on the
keyboard.

All selected cells that can be separated into parts will be separated:

Original cell Separated cell

! Note: Characters that are combined in one cell because they touch or overlap each other cannot be
separated using this method. Use the Knife tool (described below) instead.
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 Knife Tool

With the Knife tool you can separate characters that touch or overlap each other. Characters of this kind
cannot be separated using other methods, because it is not possible to distinguish overlapped characters
from characters of special form:

To separate overlapped characters:

1. Select the Knife tool  in the Tools toolbox or choose the Knife command from the Tools menu.

2. Position the mouse cursor at the beginning of the line that will separate the characters.

3. Click the mouse button to start defining a straight line segment or press the button to begin a freehand
line.

4. Move the mouse to define a straight line segment or to draw a freehand separating line.

5. Click the mouse button again to finish defining the straight line segment or release the button to finish
drawing the freehand line. The separating line must intersect the blue-highlighted contour of the
characters.

6. Double-click the mouse button to separate the characters.

After you finish separating the characters, the Symbol tool will be automatically selected. If you want to
separate more than one character, you may select the Knife tool permanently. To do this, hold down the
CMD key on the keyboard while selecting the Knife tool.

Deleting Cells

To delete split cells:

1. Using the Symbol tool, select the cells that you want to delete.

2. Select the Delete command from the Edit menu or from the popup menu that appears by pressing the
mouse button with CTRL key pressed. Or, just press the DEL key on the keyboard.

The selected cells disappear. Their contents will not be removed from the image, just the separating
information will be lost. You can use the Undo command to restore cells.
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Defining the Scale Factor

When you print text using a word processor or page layout program, you always have to choose the print
size. The print size is measured in points that are equal to about 1/72 of inch. However your printer (or
software if you are just viewing the text on the screen) has to transform the point size value into a number of
device pixels. The actual size of the text line measured in pixels depends not only on the selected point size,
but on the resolution of the output device. The typical resolution of graphic displays is about 100 pixels per
inch. Resolutions of laser printers may vary from 300 dpi to 1200 dpi. The printing resolution of professional
imagesetters may be as high as 2400 or even 3600 dpi.

All the fonts used in today's typography are scalable. This means that all the characters' shapes are
mathematically defined and may be scaled to any pixel size when printing. Every print program scales the
font's characters with two parameters in mind: the point size of a text string and the resolution of the output
device. Originally, all characters in an outline font are defined in a common coordinate system. For example,
all characters of PostScript Type 1 fonts usually have a 1000-unit coordinate system. This means that the
actual font size (defined in the font) is equal to 1000 units. Most TrueType fonts are defined in a different
coordinate system, where the font height is equal to 2,048 units.

ScanFont performs an operation that is actually the opposite of printing: it converts an image of the
characters to their outline representation that can later be printed. Scanning in this operation is opposite to
printing. As with printers, scanners may be of different resolutions. This means that they can scan the same
picture, but the resulting size of the digital image (measured in pixels) may be very different. The scanning
resolution may vary from 200 dpi (low-cost hand scanners) to 5000 dpi (high-end drum scanners), so the
image size and size of each character in the image must be declared in common units, that will not be
dependent upon the physical size of the characters or the scanner's resolution.

The easiest way to do this is to measure the font height. Knowing the pixel value of the font height allows
ScanFont to compute the scale factor that can be applied when converting the character's images to outline
characters. Usually ScanFont automatically computes this scale factor when you perform Autosplit, but it
may need to be adjusted.

To declare or edit the scale factor of an image:

1. Select the Set Scale command from the tools menu or press the Set Scale button  on the Tools
toolbox.

2. The scale bar will appear on the image and the Set Scale tool panel will also appear:

The scale bar is equal to 100% of the font height. A special highlighted mark on the scale bar is 70%,
because usually the height of the uppercase character equals 70% of the font height.

3. To compute the scale factor automatically, press on the Auto button of the tool panel.

4. To scroll an image to make the scale bar visible, press the Locate button.

If you are not satisfied with the results of the scale factor's automatic detection, it can be adjusted manually.
To do this, move the scale bar onto the string of text and position it so that its length equals the font height.
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4. To move the scale bar, position the mouse cursor on it (not too close to scale bar's ends). The mouse
cursor will change to: . Press the mouse button and drag the scale bar to its new place. Then release

the button to finish moving or click the mouse button with CTRL key pressed to abort.

5. To position the ends of the scale bar, position the mouse cursor on the end that you want to move. The
mouse cursor will change to . Press the mouse button and drag the scale bar's end. Release the button

to finish. Hold down the SHIFT key on the keyboard to constrain scale bar's direction to 90 degree
increments.

6. To accept the new scale factor press OK on the tool's panel. Or double-click the mouse button. To abort
changing the scale factor, press the Cancel button on the tool's panel.

! Note: If you have characters that are traced and change the scale factor, ScanFont will ask you to retrace
all the characters to make them the same height as the characters new scale factor.

Editing Baselines

ScanFont's main purpose is to restore lost information. This process consists of several steps:

1. Transforming an image into an electronic form (scanning).

2. Determining what parts of the image relate to each character (splitting).

3. Determining the actual size of the characters (set scale).

4. Transforming the images of characters into mathematically defined outline form (autotracing).

5. Assigning the right names and codes to the characters (placing them into a font).

Now you have all the important information restored and are ready to produce a font. However, there are
some additional steps that can save time and help you to produce better fonts:

A. Analyzing the vertical positions of the characters in an image to restore information about the vertical
characters' positions that are necessary to align the characters in strings.

B. Analyzing the horizontal character's positions to restore metric information.

Step A : Usually in the source image, characters are aligned to strings. ScanFont uses this data to restore
information about a character's vertical positioning. In the string, characters are aligned to the baseline - the
zero level of the string. Some characters lie above the baseline, some of them intersect the baseline, and
some are below:

The definition of a baseline is the zero point of the vertical coordinates.

In ScanFont you can setup baselines for every line of text. When characters are extracted from an image and
placed into a font, information about the relative position of the character's image and baseline will be used,
so you will not have to reposition the baseline in every character. Using baselines in the Image Window can
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save you a lot of time, as many characters are already aligned there. That is why we recommend that you
align characters to strings when you prepare an original image.

In most cases ScanFont automatically detects the positions of all baselines when using the Autosplit
operation. It analyses characters' cells and tries to find the best position for the baselines.

If you want to remove baselines, add new ones, or change the positions of the existing baselines use the
Symbol tool.

To add a new baseline:

1. Select the Symbol tool.

2. Position the mouse cursor on the place where you want to add the baseline. Do not position the cursor on
the existing baseline.

3. Hold down the CMD key on the keyboard (the cursor changes to ) and click the mouse button.

To move or delete a baseline:

1. Select the Symbol tool.

2. Position the cursor on the baseline (the cursor changes to  ).

3. Press the mouse button and drag the baseline where you want it to go. Release the mouse button to place
the baseline on the new position.

4. Press CTRL key while dragging the baseline to remove it.
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Slanted baselines

If your image is slightly rotated (not more than 5 degrees) and you do not want to scan it again, you will not
be able to place the baselines properly:

A slanted baseline will solve this problem. You can slant the baselines to fit a rotated image. Usually this will
not distort the resulting characters. If the rotation is not severe, the distortion of the resulting characters will
not be visible.

To slant baselines:

1. Select the Symbol tool.

2. Position the mouse cursor on any baseline close to the right edge of the image to move the right part of
the baseline or close to the left part of the image to move the left part of the baseline.

3. Hold down the CMD key on the keyboard (the cursor will change to 
 
or ) and press down the mouse

button. Drag the mouse to slant the baselines.

4. To straighten a baseline, press down the SHIFT key on the keyboard and the baseline will be in a
horizontal position.

5. Release the mouse button to finish.

! Note: Every baseline will be slanted. It is not possible to slant each baseline separately.

Assigning Names to Characters

In the split image mode you can assign names to characters. This information will be used when you place
characters into a font. Characters that have assigned names will be placed in the proper font cell. Unnamed
characters will be placed at the end of the font and their names will be generated automatically.

There are two methods used to assign names to characters: the Symbol property panel or the Assign Names
command from the Operations menu.
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Using the Symbol Property Panel

To open the Symbol Property panel select the Property command from the Edit menu or from the popup
menu.

You will see the Property panel:

In the Name field you can enter or select a name for that character. Or you can enter a character in the Char
field or its decimal code in the Code field. All fields are linked, so if you modify one of them the others will
be automatically updated.

When you assign a name to the symbol you will see a caption with that name appear on top of the symbol
cell in the Image Window.

In the Split mode of the Image Window, you can assign the same name to several characters. This may be
necessary if you have many versions of the same character in the original image and yet have not decided
what version to use in your font.

The Property panel can be used if you want to examine the character's name. If you select another
character's cell, the property panel will be immediately updated.

The Assign Names Operation

A more automated way to assign names to characters is by using the Names Template panel. In this panel
you can enter names for the characters in sequence and assign these names to many characters all at once.
This is very useful when you know the sequence of the characters in your image. You may pre-program this
sequence and use it with many images that have the same characters.

Another way to use this panel is to import the names assigned to the characters in the current split image
and use this name template in other images with the same character sequence.

To open the Names Template panel, select the Assign Names command from the Operations menu.
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You will see the following dialog box:

In the Templates combo box you can select one of the templates previously saved. ScanFont automatically
searches the folder where it is installed and tries to locate an existing name template file.

You can create a template by entering names in the large template editing field. Names can be defined in
three ways: as names, as decimal codes and as characters. The easiest way is to define the characters by what
they are: A for character 'A', B for 'B' and so on. You can enter characters sequentially. However, this
technique works well only for alphanumeric characters. Their place in any encoding table is constant.

ABCDEFGHIJKLMNOPQRSTUVWXYZ

Example of a character sequence

Instead of entering characters you can enter their codes beginning with a slash (/). The code must
immediately follow this symbol and should be finished by any space character (space, carriage return or
tabulation) or by another slash (/).

ABCDEF/98/102/55 GHIJKL
Example of codes mixed with characters

The best way to identify a character is to use its name. A character's name must begin with a "/" and end with a
space or another "/".

/A/B/minus/plus CDEFG/zero/one/two/66/67/68/224/225

Example of a mixed template

If you want to enter the character "/" by itself, it must be entered twice "//".

Using an '*' instead of a character's name means that you do not want to assign a name to that character.

To prepare a name template you may enter all the information manually or use the Get button to fill the
template editing field with the name information collected from the current image. This is a very useful way
to prepare templates for a series of images that have the same sequence of characters.

To use this method you must assign the proper names to all the character cells. All cells must be checked and
edited to make sure that they include one and only one character. The best way to assign names to characters
for the first time is to place the characters into a font. Characters receive their names when they take a
position in the font.

To assign names to characters in the split image, you must press the Apply Now button. Names will be
assigned to all the characters in the image or only to the selected characters if the Apply to selected
symbols radio button is active.
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To save the names template into a file press the Save button. The standard extension for a names
template file is TPL. If you save the names template into a file with that extension and put this file into the
ScanFont folder it will instantly appear in the Templates combo box.

To open a names template file, press the Open button and locate the file in the standard Macintosh
Open File dialog box. If the template file is located in the ScanFont folder you can open it by selecting it in
the Templates combo box.

Other Split Mode Commands

To copy characters in selected cells (already combined into one bitmap image) to the clipboard:

1. Using the Symbol Select tool, select the characters that you want to copy.

2. Select the Copy command from the Edit menu or from the popup menu that appears when you press the
mouse button with CTRL key pressed.

To switch to the image editing mode, you can select any of the image editing tools, press the mode
selection button on the Standard toolbar, select the Show Image command from the popup menu, or
select the Image command in the View menu.
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Customizing Autosplit

To customize the autosplit operation:

1. Select the Preferences command from the Tools menu.

2. Select the Autosplit page:

The controls mean:

Handling very small spots Allows the scanner to ignore points or spots that are below the limit that you
enter in this part of the page. This feature can help you to avoid noise that
cannot be removed by the Enhance Image command.

Smart split options A group of controls that set the options of advanced autosplit algorithms.

Activate Smart Split
feature

Allows you to switch on and off all the Smart Split algorithms

Automatically merge
overlapped cells

Allows you to merge cells that form characters like '%'. The value in the edit
control defines how much the cells must overlap to be combined into a single
cell.

Automatically merge
stacked cells

Allows you to merge cells that sit on top of other cells. The value in the edit
control defines the length of the most common projection in relation to the
projection of a smaller cell.

Automatically detect
baselines

Allows Autosplit to detect the positions of the baselines.

Automatically
compute scale factor

Allows you to automatically compute the scale factor for the image.
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3. To change the options of the Symbol tool switch to the Image Editor page:

In the Which cells should the Symbol tool select in marquee mode?, you can choose one of two options:
select only the cells that are inside the selection rectangle, or select the cells that are either inside or
intersected by the rectangle.
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5

CHAPTER 5

Creating Characters

When we know almost everything about the characters in an image, it is then time to put them into a font.
This means that ScanFont must convert bitmap images of the characters into the outline representations
used in digital fonts, and assign the characters to their proper place in the font.
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Place into Font operation

Autotraced outlineOriginal bitmap Font

These two operations are combined into one - placing the characters into the font. Tracing characters is
performed automatically and is not apparent to you. Later, you can change the tracing parameters and
retrace the characters, but usually this is not necessary.

Placing characters into a font includes the following stages:

1. Cut out the image of a character from the bitmap image.

2. Trace the character's image and get an outline.

3. Scale the outline according to the selected scale factor.

4. Set the vertical position of the character using the information about the baselines.

5. Assign the default metrics (left and right sidebearings).

6. Assign a name to the character. This can be done automatically if information about the desired
character's position in the font is not available, or the correct name may be assigned if you correctly place
the character.

All these stages are combined into one command: Place into Font. Another way to place characters into a
font is to use drag-drop placing.

The best way to place characters is to use the split characters' image in the split mode of the Image Window.
Any part of the image can be selected in the image editing mode by using any of the 3 selection tools and
then placing the selection into the font. In this case, only the scale factor will be applied to the outline,
because information about the baselines is not available in the image editing mode.

You can place selected portions of an image (in the image-editing mode) directly into any character, adding
special effects or interesting pictures. ScanFont is very flexible. After learning all the techniques available,
you will find that this program is a very friendly tool for all your font design work.
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FontLab Server Application and Plugin Protocol

As you know, ScanFont for Macintosh has no font-editing or exporting features, so you need another
program to accept the outline characters made by autotracing in ScanFont. We will call programs that can
accept data from ScanFont or other sources "FontLab Server Applications". These programs (FontLab 3.1
for Mac and TypeTool 1.3 for Mac are good examples) can establish a communication line with ScanFont,
accept data in outline and bitmap form and report to ScanFont the results of the data transfer so it can react
properly.

Please note that you must have one of the FontLab Server Applications
installed together with ScanFont in order to create fonts. ScanFont can be used without FontLab Server
Applications, but in this case its features will be limited only to creation of EPS files.

We expect more programs to appear that will be compatible with the FontLab data transfer protocol. All
these programs will have a note saying that they can work as FontLab Server Applications. Similarly,
programs that can communicate with FontLab servers will be referred to as FontLab Client Applications.
Programs that combine server and client capabilities will be referred to as FontLab Client/Server
Applications.
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Selecting a FontLab Server Application

When ScanFont is installed on the computer where one or more FontLab server applications are installed it
finds one of them and uses it to send the results of the font autotracing. This is an automatic process by
default, but sometimes you may need to customize it.

By default ScanFont will contact the FontLab Server Application that was run before ScanFont was run. For
example, if you have TypeTool 1.3 for Mac and FontLab 3.1 for Mac installed on the computer where you run
ScanFont it will run TypeTool if it was used after FontLab and FontLab if it was run after TypeTool.

If you want to select one of the available FontLab Servers to work with ScanFont you can do that using the
FontLab Server page of the Preferences dialog box:

Press the button at the right of the "Custom:" option to see a file selection dialog box where you can choose
one of the programs that will work as a FontLab Server.
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Placing Characters into a Font

Now that you have finished all the image-editing and splitting work you are ready to produce real characters.
Please note that we use name "FontLab" to identify any of the FontLab Server Application that you run
together with ScanFont.

To place characters into a font:

1. In the split mode of the Image Window, select the characters that you want to place using the Symbol
tool.

2. Choose the Place into Font command in the Operation menu or in the popup menu that appears when
you press the mouse button with the CTRL key pressed.

ScanFont will attempt to find and launch the FontLab server application to send all selected characters.

FontLab's Font Window will appear and you will see the new characters appended at the end of the font
chart. If you select characters with assigned names and place them into a font they will appear in their
named positions.

Another way to place characters into a font is to use drag-drop placing:

1. Select the cells for the characters that you want to place into a font.

2. Position the mouse cursor over one of the selected cells and press the mouse button.

3. Drag the mouse into the characters chart of the FontLab's Font Window. Position the highlighted region
where you want to place the characters. Release the mouse button.

The drag-drop method of character placement has an advantage: you can directly position characters. If you
use the command method of placement, the characters will appear at the end of the font chart (unless they
are already named) and a name will automatically be generated. You will need to position the characters to
their proper place in the font later.

When you drop characters on the font you may overwrite existing characters. This situation can be interpreted in
two ways: replace the existing characters so that they disappear from the font, or, move them to the end of the
font for further placement. A dialog window will appear showing the conflicting characters and you will be asked
to select one of two options:

Leave the Keep replaced symbols under new names option checked to keep the replaced characters at the
end of the font, or clear this option to delete them. Think twice before deleting characters, as this operation
is not undoable.
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If you use the symbol property panel to assign the same name to more than one symbol in the split image
and try to place several characters with the same name into the font, a warning dialog box will appear and all
duplicating names will be listed:

Rename the wrong characters or remove them from the selection and place the characters into the font
again.

Autotracing Options

There is no "Trace" command for the placement of characters. Our autotracing algorithm is so fast that we
decided to hide it in the Place into Font operation. But tracing actually does take place, and the tracing
parameters can be adjusted.

To change the autotracing options:

1. Select the Preferences command in the Tools menu.

2. Switch to the Trace page.

You will see a page with two areas, Easy and Advanced:
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Easy Autotrace Options

In the Easy area you can quickly select common tracing options, changing from Very tight to Very loose. When
you select one of these easy options, ScanFont will automatically adjust all the tracing parameters. The tighter the
option you choose the more accurate the tracing will be. In other words, the outline will be closer to the original
bitmap image. This is the first law of autotracing. The second law is that the tighter the option you choose the
more nodes you will get on the outline. More nodes mean larger font files.

Usually, the Normal option will be best. If you find that the Normal autotracing option does not work for
you, you can try the other tracing options listed below:

Image size

Scanning resolution Small Medium Large

Low Tight Normal/Tight Normal

Medium Tight/Normal Normal Loose

High Normal Normal Loose

Advanced Autotrace Options

In the advanced area you can customize the autotracer settings with more detailed options:

Trace tolerance Allows you to change the distance between the generated outline and the edge of the
original bitmap

Curve fit quality Allows you to change the accuracy of the curve fitting in the generated outline

Straighten angle Defines the angle between two lines within which the autotracer will replace several
lines with one line.

Tracer may generate
curves

Switch on this check box to allow the autotracer to generate curves.

Tracer should
generate extreme
points on curves

This option (active by default) forces the autotracer to insert nodes at the extreme
points of curves.
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Using ScanFont without a FontLab Server Application
As we said before, a FontLab Server Application is necessary to use ScanFont fully, but you can use its
unique auto-tracing and image-splitting features even without a FontLab server. ScanFont can autotrace
bitmaps, convert them into industry-standard EPS format and send them to Adobe Illustrator or
Macromedia Freehand with a simple drag-drop procedure.

To place an EPS file into Adobe Illustrator or Macromedia Freehand:

1. Select the image that you want to trace in Image mode or select one or more cells in Split mode.

2. Prepare to drag-drop the selected image. In Image mode, position the cursor close to the selection edge
and in Split mode - anywhere on the selected cells.

3. Press the mouse button and drag-drop the image to Illustrator or Freehand

As we said before, a FontLab Server Application is necessary to use ScanFont at full power, but you can use
its unique auto-tracing and image-splitting features even without a FontLab server. ScanFont can autotrace
bitmaps, convert them into industry-standard EPS format and send to Adobe Illustrator or Macromedia
Freehand with a simple drag-drop procedure.
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A Note on Intellectual Property

Digital fonts are complex computer programs created with a good deal of hard work by individuals and
companies. They are valuable intellectual property and are protected by trademark, copyright, and patent
laws. The details and extent of this protection varies in different countries, but the basics are as follows:

Trademark: A font name (and only the name) may be trademarked. Only the trademark owner or
licensees may use the name to describe a font.

Copyright: Computer programs are copyrighted. In the U.S.A. this happens automatically as soon as the
program is written. Further rights may be secured by registering the copyright.

Patent: Some fonts, if they are distinctive and unusual enough, may be granted a design patent. Only the
patent holder or licensees may use this font design.

If you purchase a font and then modify it for your own use you are probably within the bounds of "fair use"
and the font licensing agreement. However, if you modify a purchased font and then sell or distribute it you
may be in violation of copyright, patent or licensing laws. Please read your font license agreement carefully
or contact the licensor to determine your rights and obligations.
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Trademark Information

All trademarks used in this manual are the property of their respective owners and are hereby
acknowledged. In particular:

FontLab Composer, FontLab, ScanFont, VectorPaint, and TypeTool are trademarks of FontLab Ltd.

Adobe, PostScript, Type Manager, and Illustrator are trademarks of Adobe Systems, Inc.

IBM is a trademark of the IBM Corporation.
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Symbol tool, 53

Options
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